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Chapter 1
Welcome to Tempus 2

Infroduction

Thank you for purchasing Tempus 2, one of the most advanced and
versatile editors available for the Atari ST.

This manual is designed to help you get the most out of the program
and we urge you to familiarise yourself with the manual before
undertaking too much work with Tempus. At the very least, you
must read the next three sections on What you need... and Making a
Backup before attempting even to use Tempus.

Please also make sure that you return your registration card to
HiSoft so that you can obtain technical support and upgrade details.

First things first ...

What you need to use Tempus

[Computer B

You can use Tempus with any Atari ST that has TOS in ROM. Tempus
will generally adapt itself to the amount of memory available in your
ST. There are certain configurable options within Tempus that affect
the way the editor uses memo.y; these are detailed later.

|Disk Drives

You can use a single- or a double-sided floppy drive or a hard disk
with Tempus. Tempus is shipped on a single-sided floppy disk, so
that you can easily make a backup of the original disk.
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Monitor T

Aside from an ST and a disk of some kind, you will have either a
colour or a monochrome monitor. If you are using a monochrome
monitor, there is nothing special that you have to be aware of to use
Tempus.

If you are using a colour monitor you must make sure that your ST is
set up for medium resolution when using Tempus. Medium
resolution can be set using Set Preferences... on the Options menu of
the Desktop. Tempus does not work in low resolution.

Using the Control Panel Desk Accessory you can alter the screen
colours of your ST to suit your needs.

Note: Remember that simply changing resolution will not alter the
DESKTOP.INF file. To make sure that your resolution is saved for the
next time you need Tempus on your ST, use the Save Desktop option
under the Options menu on the Desktop. If you want to use medium
resolution only for Tempus, save the DESKTOP.INF file only onto your
Tempus working disk.

Making a Backup

You have several ways of making a backup of Tempus. You can use
the disk copying function of the Desktop to duplicate the disk, or you
can just copy the TEMPUS.PRG file to whichever disk/directory you
want. However you do it, please make a back-up!

Support

We are continually striving to make this product better, so we are
very receptive to suggestions about how Tempus could be made more
useful to you. If enough people ask for the same types of features, the
likelihood is high that such features will be implemented in a future
release of Tempus. We are also currently developing a powerful word
processing system based on the editing technology in Tempus.
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To take advantage of the support we offer, even if only to receive the
newest major revision of the program, you must have sent us your
registration card. You will then automatically be sent any new
information about Tempus. You must also quote your serial number
for technical support, you may find it useful to make a note of it here:

Serial No.

See Appendix C for more details of Technical Support.

General Information about Tempus

Some of the most important features of Tempus are its high editing
speed and the many easily accessible editing commands. The
following is a list of some of the main features of Tempus:

e Tempus is written entirely in 68000 assembler for speed

e Tempus is only 70k in size

e  Works with monochrome and colour monitors

¢ In monochrome mode there is a choice of 8x8 or 8x16 fonts
e  Special character sets can be loaded for use while editing

e Tempus uses GEM to its fullest extent; where GEM is too slow
new routines emulate and extend the GEM calls

e Up to four files can be edited concurrently

e Size of files is limited only by available memory

e Lines can be up to 255 characters long

e  Optional word-wrap

e Optional justification of text in word-wrap mode

¢ Definition of macros as well as configurable keyboard layout
e Definition of up to 20 function keys

e Extended editing commands
- Deletion of parts of lines
- Movement/switching of lines
- Duplication of lines
- Upper- to lower-case conversion and vice-versa

e Customised file selector with 10 selectable and redefinable
pathnames, with active drives selectable by a click on a button
plus the ability to display additional information about a given
file, such as the file’s name, size and date and time of its last
modification
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Powerful but easy-to-use search and replace functions

20 separate, saveable search and replace strings, with wildcards
Cross reference generation

Checks for balanced structure

Sort of lines

Comparison of two files

Deletion of unnecessary characters like spaces, tabs etc. at the
ends of lines

Text conversion: uppercase to lower and vice versa

Built-in RPN calculator with hex, decimal, octal and binary
modes. Results can be pasted into your text

Programmable printer driver

Full range of editing functions

Three selectable cursor modes

Auto-Scroll mode to make tedious entry of long listings easier
Access to all 256 characters in the ST's character set
Configurable screen saver

Automatic save with configurable delay

Optional time display

Almost all user-configurable functions can be saved separately in
groups (the configurations are saved in the .PRG file). Some of
the groups are:

- Basic parameters such as line length

- Printer driver info

- Size and position of text windows

- Character sets

- Keyboard layout

- File selection parameters

- Layout of the function keys

Other programs can be launched with an optional command line
from within Tempus or when quitting Tempus

All of Tempus’ functions can be accessed from the keyboard
Access to most fields within dialog boxes from the keyboard
Some functions accessible from icons as well

Support for the Blitter
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Block functions:

- Selection of a block with the mouse

- Copying text without having to move block markers

- Horizontal movement of block markers (helpful when
formatting source)

Extended status display: Insert/Overwrite mode, Caps Lock etc.
Mouse pointer disappears automatically during keyboard entry
Undoable UNDO

Line numbers can be printed

Delete file command

Configurable memory usage

Grow and shrink boxes can be disabled

e Configurable delay before screen starts scrolling

Running Tempus

Take the backup of your original Tempus disk and put it in drive A:.
Double-click on the icon for drive A: to open a window which shows
the contents of the disk.

[The Files on the Disk

il

Your backup disk should contain the following files:

TEMPUS2.PRG
READ.ME

DESKTOP.INF

PRINT.INS

KEYSYS.INS

this is the editor.

this file contains the latest information about
the version of Tempus supplied and any
additions to the manual.

this file will only be on the disk if you have used
Save Desktop, a function available in the Options
menu.

this contains the initial values of the Printer
Settings.

this file contains the initial values of the
Keyboard and System Settings.

To run Tempus, double-click on TEMPUS2.PRG. When Tempus has
finished loading, the following screen will appear.

Welcome
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Tempus’ Opening Screen

You may have noticed in reading through the description above that
Tempus is a very complex piece of software. It is advisable that you
read as much of the documentation as possible so that you can get
the most use out of the program.

Conventions in the Manual

We hope that we have designed and set this manual in a way that is
easy-to-use. So that you can get the maximum use out of it we will
explain some of the conventions used:

The manual is divided up into a series of Chapters, each one
explaining and detailing a particular set of features that are logically
connected. Within each Chapter various commands are discussed
and then the method of obtaining each command is given, with a
sidebar so that it is easily seen. Characters that appear on the screen
or are typed in from the keyboard generally are shown in the Avant-
Garde font to distinguish them from the normal text. Example:
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|[Expand Text

With this command, Tempus will replace any tab characters
within the file with the number of space characters equivalent to
the current tab length (see Chapter 9 for details on how to set the
tab length).

Expand Text q_value = 16478)

- select Expand in the Special menu
- use the keyboard shortcut Control-- (Control and the
minus key)

The command is Expand Text; this is followed by a description and
then the method by which you apply the command, marked with a
sidebar. Each command can be accessed through the menus or via a
keyboard shortcut or both. You can change the keyboard shortcut
for each command and to do this you need to know the command’s
unique i_value (installation value) - this is given after each command
and can also be inspected in the KEYSYS.INS file. Details of how to
install new keyboard shortcuts are given in Chapter 10.

Concepts

The following concepts are used throughout this manual:

|Current Text/File and Current Window

Most of the commands that you can execute will be performed on the
current text or current file. This is the text file whose window is
active, i.e. uppermost on screen. The window that contains the
current text is called the current window. We will often use the words
text and file interchangeably.

The line which contains the cursor is referred to as the current line.
The concepts of the beginning of a line and the end of a line are
hopefully self-explanatory.
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Filenames

|

A file name is made up of a maximum of 8 characters for the name
and 3 characters for the file’'s extension. The name and extension

contained in a file name are separated by a period.

For example: FILENAME.EXT

IDirectories

l

Directories can be divided up into the root directory and sub-
directories. The root directory of drive C: is displayed as C:\. A sub-

directory nested two levels deep would be displayed as C:\ONE\TWO\.

'Dialog Boxes

|

Tempus primarily uses the standard dialog boxes that are available

through GEM.

Within these dialog boxes the ASCII character NUL ($00) cannot be
entered, this is a GEM limitation. However, you can enter all other
characters in the ST character and the method of doing this is

described in Chapter 2 under Using ASCII Codes.

Almost all fields in a dialog box that can be selected by clicking on

them with the mouse can also be selected from the keyboard.

Generally, this is done with the Alt key and another letter. The exact
keys used will be described for each dialog box and shown in a table

like this one:

ALt-0
Undo
ALt-A
Return
Enter

Overwrite
Cancel
Append
Rename
Rename

The keyboard shortcuts are shown in the left column of the table and
the corresponding entries in the dialog box are shown on the right,

either as the text on the button or as a description.
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Internal Errors |

In some parts of Tempus the program checks itself to make sure
nothing is wrong. If some error occurs during these checks, an Alert
with an internal error message will pop up.

If this should happen, please write to HiSoft, giving the internal error
number and an exact description of what you were doing that caused
the error. This will help us track down any obscure bugs and correct
them as quickly as possible.

|Basic Parameters

Tempus 2 is almost completely configurable by the user; you can
change all the keyboard shortcuts, install your own printer settings
and save the editor, configured as you like to use it.

The Keyboard, System and Printer Settings are held in separate files
(called KEYSYS.INS and PRINT.INS) and these need to be compiled by
Tempus in order to install them. However, there are also some Basic
Parameters that do not need to be compiled and are inherent to
Tempus 2. These are listed in Chapter 10 and mentioned throughout
the manual.

In order to save a copy of Tempus with your own settings installed,
simply choose Save Seftings ... from the Parameters menu and check
the settings you want to save. More details are given in Chapter 10.

Tempus’ Memory Management

Tempus can hold up to four separate files in memory
simultaneously. The only limit to file sizes is the total memory
available for use by Tempus. If you have 1000k free on your ST, you
can have one file of 1k length and another of 999k length and no
more. The length of a file is limited only by the available memory; if
you are editing only one file, Tempus will devote all of its memory to
that one file.

INot Enough Memory

If Tempus finds that there is not enough memory to complete an
operation, it will put up an Alert box saying so.
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Some commands will check for available memory before execution,
others will notice the lack of memory only while they are executing.
Either way, there is no danger to your text file; the command will be
aborted in both cases.

[Reclaiming Memory |

Tempus commands use memory to a greater or lesser degree.
Sometimes, Tempus will put up a small Alert box asking you to wait
for a few moments while it reclaims some memory. There is no cause
for concern. Once the reorganisation in memory is finished, the Alert
will disappear and you can continue working.

The Keyboard

[Key Combinations \

Key combinations are entered by using a modifier key such as Alt,
Control, Shift and Caps Lock in combination with another key. The
left and right Shift keys are functionally identical. A normal key is a
key that is not a modifier.

Tempus makes a distinction between six different levels on the
keyboard. A level is defined as all key combinations that can be
entered using one or more of the modifier keys. The following is a
brief description of the levels:

The Contirol Level

The Control key is pressed in combination with a normal key.

The Shift-Alt Level

Both Shiff and Alt are pressed in combination with a normal key.

The Alt Level

The Alt key is pressed in combination with a normal key.

The Shift Level

One or both Shift keys are pressed in combination with a normal key.
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The Caps Lock Level

The Caps Lock key is down while a normal key is pressed. Caps Lock
is toggled on and off by pressing the Caps Lock key. If Caps Lock is
on, Tempus will display a © in the right side of the menu bar.

The Normal Level

A normal key is pressed without any of the modifier keys and Caps
Lock is off.

Priority

The different levels have different priorities. In the above descriptions
they are ordered highest to lowest priority. For example, the Control
level has higher priority than the Alf level. Thus, if a normal key is
pressed while both Conftrol and Alt are pressed, the Alf key is ignored
due to the Control key’s higher priority.
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Chapter 2
Text Entry

The Different Text Entry Modes

Tempus 2 differentiates between two primary modes of text entry:
source mode and word-wrap mode.

The major difference between these two main modes is that in word-
wrap mode Tempus will automatically wrap your text to the specified
line length without you having to explicitly type a carriage return at
end of each line.

If you type more than the specified line length in source mode,
Tempus will come up with an Alert informing you of this fact. If you
are in word-wrap mode, the last word on the line will automatically be
brought to the beginning of the next line.

Each file in memory can have a different mode setting; the text entry
mode settings are part of the Basic Parameters.

|Switching Between Modes

You can switch between the two modes as often as you like. The only
limitation is that you must convert text that has been entered in
source mode before you can use it in word-wrap mode.

If source mode is currently active, there is a check mark next to the

Source mode entry in the Mode menu. If word-wrap mode is
enabled, Word wrap mode has a check mark next to it.

Enable Source Mode (_value = 16506)

- select Source mode in the Mode menu
- use the keyboard shortcut Shift-Alt-Q

Enable Word Wrap Mode (i_value = 16508)

- select Word wrap mode in the Mode menu
- use the keyboard shortcut Shiff-Alt-W
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ILeft and Full Justification

|

When in word-wrap mode you can specify whether your text is to be

left- or full-justified.

In full-justified mode the line lengths in the text will be made the
same through use of special characters between words. In this
manner, every line is made to have the maximum specified line

length.

In left-justified mode, there is no padding of spaces between words.

This has the cosmetic effect of the right border being ragged.

Enable Left Justification (_vaiue = 16510)

- select left justified in the Mode menu
- use the keyboard shortcut Shift-Alf-L

If left justification is enabled, its menu entry will have a check mark

next to it.

Enable Full Justification _value = 16512)

- select full justified in the Mode menu
- use the keyboard shortcut Shift-Alt-F

If full justification is enabled, its menu entry will have a check mark

next to it.

Note: Justification modes can only be selected while in word-wrap

mode.

INotes About Word Wrap Mode

Text entry behaves differently when in word wrap mode. The
following is a description of the differences you will find.

The main difference between the two text entry modes is that source

mode is line-oriented while word-wrap mode is paragraph-oriented.

In source mode the maximum line length is fixed, this is the
maximum size of one element (as Tempus perceives it). There is one
element per line on the screen. In word wrap mode the element of text
is a paragraph and the length of such an element is not previously

defined.
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In word wrap mode one element, i.e. one paragraph, can be
distributed over multiple lines on the screen. If the maximum length
of a line is exceeded, the line is wrapped to the next and entry
continues. A paragraph’s end is defined by the explicit entry of a
carriage return.

Since the carriage return character has a special meaning in word-
wrap mode, it cannot be used as it is in source mode. When text
entered in word-wrap mode is saved to disk, the information about
the ends of paragraphs is saved as well.

When printing word-wrapped text, paragraph information is passed
along to the printer driver as well. If this information is not to be sent
to the printer, the meaning of the CR character must be redefined in
the printer driver.

A paragraph is made up of a string of words.

If a word is followed by a space, then this space is considered to be
part of the word. This means that the last word in a line will always
have a trailing space; the space will not be carried over to the
beginning of the next line.

linsert and Overwrite Modes

Text entry is always made at the current position of the cursor.

In insert mode, the text following the cursor is moved one character
to the right and the typed character is inserted at the cursor
position. Then the cursor itself is moved one character to the right.

A character entered while in overwrite mode will replace the character
at the current cursor position. After the new character is entered, the
cursor moves to the right of the new character.

Each of the files in memory can have a different insert/overwrite
mode setting. The setting is part of the Basic Parameters.

Enable Insert Mode «_value = 16514)

- select Insert mode in the Mode menu
- use the keyboard shortcut Alt-|

If insert mode is enabled an | will be visible to the right of the
Parameters menu title. The menu item Insert mode in the Mode
menu will have a check mark next to it as well.

Text Entry Tempus 2 Page 15



Enable Overwrite Mode (_value = 16516)

- select Overwrite mode in the Mode menu
- use the keyboard shortcut Alt-O

If insert mode is enabled an O will be visible to the right of the
Parameter menu title. The menu item Overwrite mode in the Mode
menu will also have a check mark next to it.

|/Auto Indent

Auto indent mode is independent of any of the other mode settings.

If auto indent is enabled then, upon hitting Return or Enfer, Tempus
will check whether the line that has just been ended was indented in
any way. If it was, the same indentation will apply to the newly-
created line. The cursor will also be positioned under the first
character of the previous line. The only exception to this is if the
terminated line contains only spaces.

Auto indent mode is very useful when entering structured program
source and saves you having to explicitly indent a new line every time.

Auto indent is enabled/disabled separately for each of the files in
memory. The settings are part of the Basic Parameters.

Toggle Auto Indent Mode (i_value = 16518)

- select Auto Indent in the Mode menu
- use the keyboard shortcut Alt-A

If auto indent is enabled, a check mark appears next to its menu
entry.

Auto Scroll Mode

|

Auto Scroll mode can be enabled/disabled independently of all other
modes. In auto scroll mode the contents of the window are scrolled
up one line every time the Return or Enter keys are used. This means
that the cursor remains on the same line on screen, and is thus
easier to find.

This mode is useful when typing in large amounts of text; finding the
cursor is much easier on the eye since it's always in the same vertical
position.

Page 16 Tempus 2 Text Entry



Auto scroll is enabled/disabled separately for each of the files in
memory. The settings are part of the Basic Parameters.

Toggle Auto Scroll ¢_value = 16520)

- select Auto scroll in the Mode menu
- use the keyboard shortcut Shift-Alt-Z

If auto indent is enabled, a check mark appears next to its menu
entry.

[Maximum Line Length

If you are typing in source mode and a line becomes longer than the
defined maximum line length, an Alert appears warning you that the
line is too long; you should shorten the line in some way.

In word-wrap mode the Alert appears if a line becomes longer than
255 characters. Tempus cannot process lines that are longer than
255 characters.

Notes About Text Entry

You can enter text generally only in the current window. Each of the
files in memory has a separate cursor position. The cursor position
determines where text entry occurs.

[Disappearing Mouse 0

So that the mouse cursor is not in the way, it is removed when a
normal character is typed or when some commands are executed.
Moving the mouse will cause the mouse cursor to reappear.

[Entering Special Characters |

The Character Set Command

The character set command provides a dialog box from which you
can choose characters from the ST character set. You can use this
dialog box to build a string that will be inserted at the current cursor
position when you click on the Done button.
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Character Set (_value = 16474)

- select Character Set... in the Special menu
- use the keyboard shortcut Control-+

The following dialog box will appear:

To select one of the displayed characters, just click on it with the
mouse pointer. While the left mouse button is depressed, the
character under the pointer will be displayed in inverse video.

If you double-click on a character, it will be added to the end of the
built string and then the built string will be copied into the text, as if
the Done button had been selected.

Clicking on the Done button will cause the string built at the bottom
of the dialog box to be inserted into the text at the current cursor
position. The Return and Enter keys have the same effect as clicking
on Done.

Clicking on the Cancel button causes you to return to your text
without the text being altered. Any characters you may have selected
while in the dialog box are lost. Pressing the Undo key will have the
same effect as clicking on Cancel.

Undo Cancel
Return Done
Enter Done
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Using ASCIl codes

Normally, most special characters in the ST character set are not
accessible directly through the keyboard.

Within Tempus, one way of getting at these characters is by using
the Character Set command. However, this will interrupt the flow of
writing, since you have to devote your attention to using the mouse.

There is a second way of accessing these special characters by
entering the ASCII code of the character that you want. This method
will work in most of Tempus’ dialog boxes as well as in the current
text window.

To generate a character, hold down the Alt key and enter the ASCII
code of the character that you want on the numeric keypad of your
ST keyboard. Let go of the Alt key only after you have entered all the
digits of the ASCII code. If three digits are entered, the character is
automatically generated. If only two digits are entered, the character
will not be generated until the Alf key is let go.

If you want to enter multiple special characters, it is advisable to
enter the ASCII codes as three-digit codes so that you can rapidly
enter the sequence. If an ASCII code is only one or two digits in
length, use preceding zeros to make it a three digit number.

Note: Because of this feature there has been a small change in
keyboard shortcuts from previous versions of Tempus. The affected
command is Quit and Save without Backup. This command was
moved from the Alf level to the Shiff-Alf level.

Editing Commands

The following is a description of the available editing commands
within Tempus 2.

Delete to End Of Line «_value = 16676)

Alt-. (Alt and full-stop; think of it as Alt->)

The text under the cursor and following it on the current line is
deleted.
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Delete to Beginning Of Line d_value = 16674)

l Alf-, (Alt and comma; think of it as Alt-<)

The text under the cursor and preceding it on the current line is
deleted.

Swap Line Up d_value = 16718)

| Control-~

The current line is moved up one, i.e. the line above the current line is
swapped with the current line.

Swap Line Down (_value = 16720)

| Alt-~

The current line is moved down one, i.e. the line below the current line
is swapped with the current line.

Duplicate Line (i_value = 16680)

’ Control-Insert

The current line is duplicated; the cursor ends up on the lower of the
two lines.

Move Line (_value = 16690)

l Alt-Backspace

When Alt-Backspace is entered for the first time, the current line is
copied into an internal buffer and deleted from the current text. Now
move the cursor to the line where the copied line should go and press
Alt-Backspace again. The line will be copied out of the internal buffer
into the text. The line on which the cursor was positioned is moved
under the copied line.

Tab Forward (_value = 16582)

Tab

The cursor and any text under and following it are moved forward to
the next tab position. The open space created is filled with spaces.
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Tab Backwards d_value = 16726)

Control-Tab

The cursor and any text under and following it are moved backward
to the nearest preceding tab stop. Any intervening text is deleted.

Limited Tab Backwards _value = 16724)

Alt-Tab

If there are spaces preceding the cursor, they are deleted until the
nearest preceding tab stop. The cursor is moved backwards as well.

Uppercase/Lowercase Conversion (_value = 16678)

Control-G

The character under the cursor is toggled from upper to lowercase or
vice versa. The cursor is moved right one column.

Delete Word (_value = 16574)

Control-T

If the cursor is at the beginning of a sequence of spaces, these are
deleted. If the cursor is within a word, the characters under and
following the cursor are deleted until a white space is reached. The
following characters are also accepted as word delimiters, i.e. Delete

Word will stop at these characterstoo: ¢ ) + = * / ¢ » . L
1 { > " * , CR Tab. You can change these delimiters, see
Chapter 10.

Delete Line (_value = 16576)

Control-Y
F8

The current line is deleted. Undo and Shift-Undo will undo this
command (see Chapter 6).
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Insert Line (_value = 16596)

| Shift-Insert

An empty line is inserted in front of the current line.

Insert Character d_vaiue = 16594)

l Insert
The text under and following the cursor on the current line is moved

one character to the right. A space character is inserted into the
created space. The cursor position is not changed.

Delete Character (_value = 16586)

Delete

The character under the cursor is deleted and the following text is
moved to the left to fill the gap. The cursor position is not changed.

If the cursor is at the end of a line, nothing will happen. You cannot
delete characters on following lines with this command.

Delete Character on Following Lines d value = 16588)

Shift-Delete
This is an extension of Delete Character. If the cursor is at the end of

a line when this command is executed, the following line is appended
to the current line.

Delete Character to Left of Cursor «_vaiue = 16578)

Backspace

The character to the left of the cursor is deleted. The characters
under and to the right of the cursor are moved left to fill the gap.

If the cursor is at the beginning of a line, nothing will happen. You
cannot delete characters on preceding lines with this command.
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Delete Character on Preceding Lines (_value = 16580)

Shift-Backspace l

This is an extension of the Backspace command. If the cursor is at
the beginning of a line, the current line is appended to the preceding
line.

|Horizontal Block Movement

The two following commands move the text selected in a block one
character forward or back. These commands can be used to format
structured source code.

All lines that are to be affected must be part of the selected block. The
starting column of the block is only relevant since the commands
affect all text on the line after the starting column position.

Move Block to the Right d_value = 16686)

Control-Space ' |

The lines of text within the marked block are moved one character to
the right. The resulting gap is filled with spaces.

Move Block to the Left (_value = 16688)

Alt-Space I

The lines of text within the marked block are moved one character to
the left. Those characters preceding the start of the block are deleted.
You cannot delete beyond column O in this way.

|Cursor Positioning

Text entry is possible only in the current file. Each file has its own
cursor. The position of the cursor determines where characters are
entered in the current file.
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([Cursor Positioning Modes

Each file can have one of three cursor positioning modes active:

a) Free Cursor Positioning

In this mode, the cursor can be placed on any line in any column less
than or equal to the maximum line length. Thus, the cursor can be
positioned at a place where there is no text. When the cursor is
moved vertically its column position is maintained.

Enable Free Cursor Positioning d_value = 16522)

- select Free in the Mode menu
- use the keyboard shortcut Shift-Alt-Numeric 9

b) Keep within Text

In this mode, the last column in which a cursor can be positioned is
determined by the amount of text in a given line. The cursor can only
be placed where there is already text, or at the position after the last
character on a line. When the cursor is moved vertically its column
position will be maintained.

Enable Keep within Text (_value = 16524)

- select Keep prev col in line in the Mode menu
- use the keyboard shortcut Shift-Alt-Numeric 8

c) Keep within Text and maintain Original Column

This mode is identical to mode b) except that Tempus will attempt to
retain the original column position of the cursor during multiple
commands that move it up and down.

For example, say there are three lines:
- Line 1 contains 40 characters

- Line 2 contains 10 characters
- Line 3 contains the cursor at column 20
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Starting at (line 3, column 20), moving the cursor up one line will put
it at (line 2, column 10), since there are only 10 characters in that
line. Move it up one more line and the cursor will be placed in (line 1,
column 20), restoring the original column from line 3. In mode b) the
cursor would go (line 3, column 20), (line 2, column 10), (line 1,
column 10), preserving the previous cursor position, where possible.

Enable Keep Original Column (_value = 16526)

- select Keep 1st-line column in the Mode menu
- use the keyboard shortcut Shift-Alt-Numeric 7

All previous versions of Tempus used mode c).

Each of the files in memory can have a different positioning mode
setting. The setting is part of the Basic Parameters.

[Cursor Commands T

The following commands apply only to the cursor that is in the
current window.

The visible area of the text in the current window should almost
always contain the cursor.

Move Cursor Left (_value = 16600)

Arrow Left I

The cursor is moved one character to the left. If the cursor is at the
beginning of a line, it is moved to the end of the previous line.

Move Cursor Right «_value = 16598)

Arrow Right |

The cursor is moved one character to the right. If the cursor is at the
end of a line, it is moved to the beginning of the following line.

Move Cursor Up d_value = 16602)

Arrow Up |

The cursor is moved up one line.
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Move Cursor Down (_value = 16604)

| Arrow Down

The cursor is moved down one line.

Scroll Up d_value = 16610)

’ Shift-Arrow Up

The contents of the window move down one line. The cursor is not
moved.

Scroll Down (_value = 16608)

| Shift-Arrow Down

The contents of the window move up one line. The cursor is not
moved.

Move to Beginning of Line (_value = 16566)

‘ Shift-Left Arrow
F3

The cursor is moved to the beginning of the current line.

Move to End of Line (_value = 16568)

‘ Shift-Right Arrow
F4

The cursor is moved to the end of the current line.

Note: in Free Cursor Positioning mode, if the cursor is on the last
character on a line, it is moved to the maximum line position.

Move Word Left _value = 16570)

Control-Arrow Left
F5
Control-A

The cursor is placed at the beginning of the preceding word. If the
cursor is already at the beginning of the line, nothing will happen.
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Move Word Right (_value = 16572)

Control-Arrow Right
F6
Control-F

The cursor is placed at the beginning of the following word. If the
cursor is already at the end of the line, nothing will happen.

Move Cursor to Next Tab Stop «_value = 16584)

Shift-Tab

The cursor is placed on the following tab stop. If the next stop cannot
be reached, the cursor is placed at the end of the line.

Move Cursor to Previous Tab Stop _value = 16722)

Alt-Shift-Tab

The cursor is placed on the previous tab stop.

Page Up (_value = 16554)

g:]onfrol—Arrow Up
Control-R

The contents of the window are moved down a whole page of text. The
cursor is effectively moved with the text which means that in most
cases it will stay in the same screen position; the exception to this is
when you are Paging Up within the first two pages of text in which
case the cursor will try to move a whole page but the display may not
reflect this and the cursor position will change - try it out.
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Page Down (i_value = 16556)

Control-Arrow Down
F2
Control-C

The contents of the window are moved up a whole page of text. The
cursor is effectively moved with the text which means that in most
cases it will stay in the same screen position; the exception to this is
when you are Paging Down within the last two pages of text in which
case the cursor will try to move a whole page but the display may not
reflect this and the cursor position will change - try it out.

Move cursor to start of following line d_value = 16684)

Shift-Return
Shift-Enter

The cursor is moved to the beginning of the following line.

Cursor Home (_value = 16606)

I Home

The cursor is moved to the first character in the window.

[Using the Mouse |

You can position the cursor within the current window with the
mouse simply by clicking on where you would like the cursor to be.

Bookmarks

A bookmark marks a specific place in a file, it contains the co-
ordinates of the row and column.

If changes to the text cause a marked area of text to be moved, the
bookmark moves as well.

Bookmark Commands |

A maximum of five bookmarks can be defined per file. The bookmarks
are numbered 1 through 5.
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A bookmark is placed by positioning the cursor where you would like
the bookmark to be and executing the appropriate command.

Set Bookmark 1 (_value = 16428)

- select Bookmark 1 in the Goto menu
- use the keyboard shortcut Control-1

To set bookmarks 2-5 use Confrol-2 through Control-5 or the
analogous menu selections.

Jump To Bookmark 1 d_value = 16400)

- select the area to the right of the Bookmark 1 entry in the
Goto menu
- use the keyboard shortcut Alt-1

To jump to bookmarks 2-5 use Alf-2 through Alt-5 or the analogous
menu selections.

The line number of a marked Bookmark is displayed in the relevant
menu entry.

Set Bookmark 2 (_value = 16430)
Set Bookmark 3 (_value = 16432)
Set Bookmark 4 _value = 16434)
Set Bookmark 5 (_value = 16436)

Jump to Bookmark 2 (i_value = 16402)
Jump to Bookmark 3 (_value = 16404)
Jump to Bookmark 4 (_value = 16406)
Jump to Bookmark 5 (_value = 16408)

Other Quick Access Methods

Aside from using the 5 Bookmarks, you can also jump directly to
other parts of your text. In these cases the relevant line number is
also displayed in the respective menu entries.

Jump to Beginning

This command places the cursor in line 1, column O.
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Jump To Beginning d_value = 16442)

- select Text start in the Goto menu
- use the keyboard shortcuts Alt-T or Shift-Home

Jump To End

This command places the cursor at the beginning of the last line in
the text.

Jump To End d_value = 16410)

- select Text End in the Goto menu
- use the keyboard shortcuts Alt-E or Contfrol-Home

Jump To Line

The jump to line command puts the cursor at the beginning of the
specified line. When calling this command you will enter the line
number in a dialog box.

After entering the desired line number, press Return or Enter and the

cursor will be placed at the beginning of the specified line. If no line
number is entered, nothing will happen.

Jump To Line (_value = 16438)

- select Line ... in the Goto menu
- use the keyboard shortcut Alt-Z

Jump To Page

The jump to page command is identical to the jump to line command
except that you must enter a page number instead of a line number.

Jump To Page (_value = 16440)

- select (Print-) Page in the Goto menu
- use the keyboard shortcut Control-D

Note: There is a difference between screen pages and printing pages.
The jump to page command refers to printing pages which tend to be
longer than screen pages.
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Jump To Beginning of Block

This command puts the cursor at the beginning of the currently
selected block. This command is valid only if block markers are
defined.

Jump To Block Start d_value = 16412

- select Block start in the Goto menu
- use the keyboard shortcut Alt-B

Jump To End of Block

This command puts the cursor at the end of the currently selected
block. This command is valid only if block markers are defined.

Jump To Block End _value = 16414)

- select Block end in the Goto menu
- use the keyboard shortcut Alt-K

Jump To Last Position

Some commands change the position of the cursor. Before these
commands are executed, Tempus remembers the last cursor
position. The jump to last position command puts the cursor back
where it was before such a command.

Only one position is remembered. These are the commands where
the last position is remembered:

- Add Text

- Search for String

- Search Again

- Search and Replace

- Jump To Bookmark

- Jump To Line

- Jump To Page

- Jump To Beginning

- Jump To End

- Jump To Block Start

- Jump To Block End

- Jump To Last Position

- Using the vertical scroll bars
- Using the right Mouse button to change the cursor’s position
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Jump To Last Position (_value = 16416)

- select Last Position in the Goto menu
- use the keyboard shortcut Control-Z.
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Chapter 3
File Commands

The File Selector

Tempus has its own custom version of the GEM file selector. The
enhancements are:

The command that caused the file selector to appear is
displayed.

A pathname can be up to 42 characters long.

Buttons to select available drives quickly are provided.

Used and unused space on disk is displayed.

Names, sizes, modification dates and times of files in the
current directory can be displayed.

10 selectable search masks are provided as buttons for quick
access. The masks can be customized to fit your needs and
saved on disk.

Save as...

KEYSYS .BAK
KEYSYS .INS
Pig SCR
p? .SCR
PRINT  .BAK
PRINT  .INS
READ HME

SHAPDA .ACC
SHPSHT .TOS
TEHPUS2 .PRG

The Tempus File Selector
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[The Pathname |

The path field can contain a maximum of 42 characters to specify the
current search path and search mask. Such long pathnames are
usually the result of having documents in sub-directories that are
nested several levels deep.

If you enter a path via the keyboard, as opposed to selecting sub-
directories with the mouse, you must click on one of the selectable
objects, e.g. the search mask buttons, for the new path to be
recognised. If the path string that you enter is invalid, Tempus will
try to correct it as best it can.

'Selecting Files |

You can select the displayed files both via the mouse and by using the
keyboard. If you double-click on an entry in the list, you not only
select that particular file, but also leave the dialog box. You can also
enter the file’'s name via the keyboard; the name is displayed in the
File Name editable text field.

The Search Mask |

The search mask can help you narrow down the choices that are
displayed in the file selector dialog box. This way you can search
specifically for files with certain extensions and avoid scrolling up
and down the list to find the file that you are looking for. By clicking
on one of the buttons, you change the search mask in the path name
field. You can also change the mask manually by altering the path
name field directly.

The displayed directory is not altered by selecting another search
mask. Only the files in that directory conforming to a search mask
will be displayed; if you change masks, only those files conforming to
the newly selected mask will be shown.

[Directories |

You can move around the directory hierarchies in different ways and
directly edit the path string to suit your needs. You can select the
name of a sub-directory by single-clicking on it. To rise one
hierarchical level higher, single-click on the close box in the file
selector. Double-clicking on the close box causes the root directory of
the current drive to be displayed.
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IDrives

As with directories and search masks, you can also change the drive
being looked at by editing the path string. The buttons to the left of
the list of files makes selecting the current drive easier. Up to 7 drives
will be given buttons. If there are more drives on-line, you can access
them only by changing the path string.

Tempus associates a path with each drive. If you change drives and
then change back, Tempus will remember the entire path as you had
left it before changing drives.

File Information

Additional file information can be displayed by Tempus. To cycle
through the different display options, use the arrow keys on the side
of the bottommost field of the display list.

This field contains the information type currently being displayed.
There are four types: file name, file size, last modification time and
last modification date.

IRead Directory

To cause Tempus to read (or re-read) a directory, select one of the
search mask fields. If a re-read is desired, click on the current search
mask.

[Changing the Search Masks

By double-clicking on them, you can edit the buttons that contain
the search masks. Once you have double-clicked, the button turns
into an entry field of up to five characters in length.

When you are done, single-click on the field to use the edited search
mask to display the current directory. A re-read can be suppressed
by using Return or Enter, or double-clicking again.

Any changes made to the search mask buttons can be saved. They
are part of the File Selector parameters.
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Drive Information ]

By double-clicking on a drive button, you can have Tempus display
allocation information about the drive. This is only available for those
drives that have a button.

The following information is displayed: total capacity of the drive, free
space on the drive, used space on the drive and the number of files
and sub-directories in the current directory.

The number of files is dependent on the current search mask.

Installable File Selection Parameters |

Some of the settings that can be made in the file selector can be saved
as part of the File Selector parameters.

The saveable settings are: the 10 search masks, the path and the
displayed file name.

The keyboard shortcuts for the file selector are on the next page.
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[Keyboard Shortcuts 2

ALt=S Close button
ALt-M Select Filename field
AlLt-0 Scroll down
ALt-K Scroll up

F1 Disk drive button
F2 Disk drive button
E3 Disk drive button
Fé& Disk drive button
F5 Disk drive button
Fé6 Disk drive button
E7 Disk drive button
AlLt-1 Directory item
AlLt-2 Directory item
ALt-3 Directory item
Alt-4 Directory item
ALt-5 Directory item
ALt-6 Directory item
ALt =7 Directory item
ALt-8 Directory item
ALt-9 Directory item
ALt-0 Directory item
ALt== Directory item
Shift-F1 Search mask
Shift—F2 Search mask
Shift-F3 Search mask
Shift-Fé& Search mask
Shift-=F5 Search mask
Shift—-Fé Search mask
Shift=E{( Search mask
Shift-F8 Search mask
Shift-F9 Search mask
Shift-F10 Search mask
Control—-« Attributes box left
Control-— Attributes box right
Undo Cancel

Return Load, save etc.
Enter Load, save etc.
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Loading Files

Tempus can have up to four files open at the same time.

After loading a file, Tempus will check whether the file’s lines are of
an acceptable length. If there is a problem, the following dialog box will
appear:

Lines too long!

There are four different ways of continuing.

Wrap: those lines that are longer than the specified maximum length
will be wrapped around to a newly created next line. This way the
maximum line length remains in effect and you lose none of the data
that was on parts of lines greater than the maximum line length.

Cancel: the file is not loaded.

Truncate: those lines that are longer than the maximum line length
will be truncated. All data from the ends of the long lines will be lost.

Fit line length: the maximum line length is changed to fit the longest
line in the loaded file. If any line is longer than 255 characters, this
button will appear crossed out. This means that if you select it, all
lines that are longer than 255 characters in length will be truncated
and the maximum line length will be set to 255 characters.

AlLt-K Wrap

Undo Cancel
AlLt-S Truncate
Return Fit line length
Enter Fit line length
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|lLoad File

This command will load a file from disk into one of the four available
slots. If there are already four files being edited, this command
cannot be executed.

Tempus’ file selector dialog box will appear. Here you either select the
file to load or the name of a file to be created.

If the file that is entered does not already exist, Tempus will prompt
you whether you wish to create a new file.

Unless you have aborted the process at some point, a text window

will then open. It will be empty in the case of a newly created file, or
will contain the contents of the file that has been loaded.

Load File d_value = 16536)

- select Openfile... in the File menu
- use the keyboard shortcut Alt-X

IRestoring a File

|

This command is similar to the load file command. It will reload the
current file from disk into the current window, overwriting the
current window’s contents. This is useful if you realise that you have
made some mistakes editing this file and want to start again.

Reload this File (_value = 16418)

- select Reload in the File menu
- use the keyboard shortcut Control-U

[insert Text ¥

The Insert Text command takes the contents of an existing file and
inserts it at the current cursor position within the file being edited.

Insert Text _value = 16420)

- select Insert text... in the File menu
- use the keyboard shortcut Alt-R
- move the DISK icon over the current text’s icon
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Saving Files

If, when saving a file, an alert appears telling you that there is not
enough room to save the entire file, Tempus will save as much of the
file as it can. If you wish to delete the fragment that Tempus has
saved, you must explicitly do it with the Delete file... command.

'Save with Backup |

This command will save the current file under its current name. If a
file of that name already exists, its extension will be changed to BAK
so that the current text can be saved under its own name. If a file with
the same name and BAK extension exists, it will be deleted to make
room for the new BAK file.

Save with Backup (i_value = 16422)

- select With Backup in the File menu
- use the keyboard shortcut Control-S
- drag the current text’s icon onto a DISK icon.

'Save without Backup |

This command is identical to the previous command except that it
does not create a backup file, nor does it affect any existing duplicate
files in any way. If a file with the same name and extension as the
current file exists, it will be overwritten.

Save without Backup d_value = 16424)

- select Without Backup in the File menu
- use the keyboard shortcut Alf-S

'Save As |

This command lets you choose the name of the file to be saved before
the file is actually saved.
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Save AS (_value = 16426)

- select Save as... in the File menu
- use the keyboard shortcut Alt-W

If a file with the chosen name already exists, the following dialog box
will appear

Name conflict!

You have four ways of proceeding. Cancel aborts the command.
Overwrite causes the already existing file to be overwritten. Rename
changes the already existing file to have a BAK extension. Append
causes the current text to appended to the existing file.

ALt-0 Overwrite
Undo Cancel

ALt-A Append
Return Rename
Enter Rename

If you have changed the path during the course of a save then, when
the save has finished, you will be prompted whether Tempus should
retain the path setting as the current path.

Deleting Files

You can delete files with the Delete File command. Using Tempus’ file
selector, you select the file that is to be deleted. Before the file is
actually deleted, you will be asked once more whether you really wish
to delete the file.
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Delete File (_value = 16538)

- select Delete file... in the File menu
- use the keyboard shortcut Shift-Alt-D
- drag the DISK icon to the TRASH icon
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Chapter 4
Block Commands

While editing a text file it is often useful to be able to copy, delete and
save selected areas of text. Tempus’ block commands support these
functions and more.

Defining a Block

Before executing any of the block commands, a block must first be
defined. This is done by choosing the start and the end of the block.

In monochrome, a block is seen on the screen as being on a grey
rather than a white background. On colour screens, the text in a
selected block is displayed in different colour from the rest of the file.

Note: If the block end is before the block start, the area in between is
referred to as the inverse block. As of this version of Tempus, almost
all block commands have no effect on the inverse block area. If you try
to use a block command on an inverse block area, an alert will appear.

You can move blocks between files.

[Setting Block Markers ]

The two commands Set block start and Set block end define the
beginning and end of a block, respectively.

Set Block Start ¢_value = 16470)

- select Set block start in the Block menu
- double-click on a character in the text file
- use the keyboard shortcut Control-B

Set Block End (_value = 16472)

- select Set block end in the Block menu
- double-click on character in the text with the right mouse key
- use the keyboard shortcut Control-K
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[Missing Block Definition \

If a block command is executed with either the block start or end
undefined, Tempus will define the missing marker automatically. If
the start is missing, the beginning of the text is set to be the start. If
the end is missing, the end of the text is set to be the end of the block.

The Block Commands

'Move Block o

This command will move the contents of the marked block to the
current cursor position. A block cannot be moved within itself.
Moving a block effectively deletes it from its original position.

Both of the block markers are moved as well, so are any bookmarks
within the block.

Move Block (_value = 16392)

- select Move block in the Block menu
- use the keyboard shortcut Control-V
- drag the Block icon to the text’s icon

Copy Block with Markers |

The Copy Block command copies (i.e. does not delete the original
block) the block to the current cursor position. The start and end
block markers are moved to the copy.

Copy Block with Markers _value = 16396)

- select Copy with markers in the Block menu
- use the keyboard shortcut Alt-C

|Copy Block without Markers |

This command is identical to the previous command, except that the
block start and end markers stay with the original block.
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Copy Block without Markers (_value = 16394)

- select Copy without markers in the Block menu
- use the keyboard shortcut Shift-Alt-C

Delete Block |

This command deletes the contents of the block area from the text. It
can be undone with the Undo key.

Delete Block (_value = 16398)

- select Delete block in the Block menu
- use the keyboard shortcut Alt-Y
- drag the Block icon to the Trash icon

'Save Block

This command enables you to save the contents of the block to a
separate file.

Save Block (_value = 16384)

- select Save block as... in the File menu
- use the keyboard shortcut Confrol-W
- drag the Block icon to the Disk icon

[Print Block

This command prints the contents of the block.

Print Block (_value = 16384)

- select Print block in the Block menu
- use the keyboard shortcut Alt-P
- drag the Block icon to the Printer icon

[Delete Block Markers

This deletes the block markers and removes the visual effects of the
marked block area.
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Delete Block Markers (_value = 16388)

- select Remove block markers in the Block menu
- use the keyboard shortcuts Control-H or F10

|Complement Block Markers d

Redefines the block markers so that the previously non-block area
becomes the marked block and vice versa. This may not always be
useful and can mean that you may have two marked blocks. Many of
the block commands will not work if you have two marked blocks and
you will be told this by an alert box. However, this command can
sometimes be useful if you have a block that either starts at the start
of the file or ends at the end of the file.

Complement Block Markers _value = 16386)

- select Complement block in the Block menu
- use the keyboard shortcut Alt-H

Page 46 Tempus 2 Block Commands



Chapter 5
General Commands

Search and Replace

Tempus 2 has a wide range of very powerful search and replace
features. You will only get to know them well by trying them out; we
suggest that you take a backup of any text file before experimenting
with replace!

'Search

Tempus’ search command will not work over multiple lines. The
string that is to be searched for must be on one line only.

Search (_value = 16444)

- select Search... in the Text menu
- use the keyboard shortcut Control-L

The following dialog box will appear:

Single wildcard: '?
1ti wildcard:

The string that is to be searched for should be entered in the editable
text field near the top of the dialog box.
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Switching to other strings

Tempus has a buffer for up to 20 search strings. By using the arrow
buttons to the left of the field, you can scroll through the strings that
Tempus has remembered.

There are various options that allow you to control the search.

Search Area

You can search over the entire file, the current block (if there is one
selected) or a specified area. If you choose to explicitly define an area
by clicking on Selected areaq, you will see two editable text fields
appear. The line numbers of the start and end search lines should be
entered in these fields.

Search Direction

The search direction is relative to where the search starts. If you are
searching the entire file, you can specify whether to start at the
beginning of the file, the end of the file, or at the current cursor
position. If you are searching within a block, you can start searching
from the start or end of the block, or from the current cursor
position. The same options are available for an explicitly specified
area.

Case Differentiation

You can choose whether Tempus will differentiate between upper and
lower case in the search string and subsequently during the search.
Click Yes against the Match U/L: question to search for the string
exactly as entered, click NO to ignore the case of the string.

Search area within a line

Since Tempus’ searches work on a line-by-line basis, you have the
option of specifying which part of any given line is to be searched. For
instance, you can specify that only the first 20 characters in a line
are searched before Tempus goes on to the next line.

The first and last columns can be specified in the editable text fields
to the right of the Match U/L: buttons in the dialog box.
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Wildcards

You can specify two different types of wildcards in your search
string. The single wildcard, ?, stands for one character of any value,
while the multi wildcard, *, stands for any number of characters of
any value. For example, the search string ???day would find both
Monday as well as Friday. The string *day would find any string that
ended in the three letters day.

You can change the characters that are to be used as wildcards. They
are part of the Basic Parameters.

The Search

After you have entered the appropriate information in the search
dialog box, pressing Return or Enter will start the search. If you wish
to leave the dialog box without starting the search, click on the
Cancel button, or press Undo.

If Tempus finds a string matching your search string, the cursor will
be placed at the beginning of the found string. If Tempus could not
find the string, a dialog box will appear asking you whether you wish
to enter a new search string or go back to editing your text.

|Search Again

This command is useful if you would like Tempus to search again
with the same search string and the same options. This way you can
avoid having the search dialog box appear every time; Tempus will
start the search immediately. If there is no current search string,
Search Again cannot be executed.

Search Again (_value = 16446)

- select Search again in the Text menu
- use the keyboard shortcuts F7 or Alt-L

'Search and Replace ]

The search and replace command is an extension of the search
command. Instead of simply finding a string, you can replace the
found string with another. The differences in the Search and
Replace dialog box are that there is a second line for the replacement
string and you can choose how many times the replacement is done.

General Commands Tempus 2 Page 49



The replacement field also has arrows to scroll through the 20 line
buffer of replace strings. This is not a separate buffer from the search
string buffer. A problem can arise when both the search and the
replacement string have the same buffer number (visible in the little
box to the left of the up/down buttons). If one of the strings is
changed, the other field will not reflect the change, although
internally the strings are identical.

You can use wildcards in the replacement string. Any wildcard in the
replacement string refers to a wildcard in the search string. The
wildcard in the replacement string signifies the characters that are
the same as those specified by the search string wildcards.

Wildcards in the replacement string field contain the wildcard
character and a numeral O to 9; up to 10 wildcards from the search
string may be referenced. You can reference a wildcard from the
search string more than once.

Example:

Search string: They went * on *

Replacement string: They are going *0 before *1

would change: They went swimming on Tuesday

to: They are going swimming before Tuesday

If the references between search and replacement wildcards are
unclear, an alert will appear.

You have the option of specifying how many replacements are made.
A search and replace can be done Once or Tempus can Ask before
replacing, or you can replace throughout the entire file with the All
option.

If you select Ask, every time Tempus finds a matching string, it will
display the string in the fourth line from the top of the screen,
highlighted. You then have the option of replacing the found string,
continuing with the search or aborting the search.

After Search and Replace has finished, a dialog box will appear telling
you how many times the search string was replaced.

Note: You can abort the Search and Replace process by pressing both
mouse keys simultaneously.
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AlLt-U Previous search string
ALt-H Next search string
AlLt-0 Previous replace string
AlLt-K Next replace string
Alt-J Yes to Match U/L:
ALt-N No to Match U/L:
ALt-G Whole text

AlLt-B Block area

AlLt-W Selected area

ALt=Y At cursor

AlLt-A Text start, Block start
Alt-E Text end, Block end
AlLt-V Search forward
ALt-R Search backward
AlLt-1 Once

AlLt—— Ask

Alt-1I All

Undo Cancel

Return Start

Enter Start

Search and Replace (_value = 16448)

- select Search & Replace... in the Text menu
- use the keyboard shortcut Alt-E

Generating Cross-References

Tempus will search through a file for a specific string and then
append a list of the string’s locations to a file. One use for this is to
determine where in a file a particular variable is referenced. When
using this command you must first set up the string using Search.

'Setting the parameters

First, use the Search command to set up the string that you wish to
cross reference together with any of the search options you would
like in force. After setting the appropriate options and having entered
the search string, you should click on Cancel. Now choose Cross
reference... from the Text menu.
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Generate Cross-Reference (_value = 16450)

- select Cross reference... in the Text menu
- use the keyboard shortcut Control-Q

The following options can be specified:

Target File

The generated cross reference must always be appended to an
existing file that has been loaded. The buttons that are available
specify which of the loaded files the list can be appended to; choose
the one you want by clicking in its box.

Position Information

You can have Tempus generate the position of the string as any
combination of line, column and page references.

References per Line

You can specify the maximum number of references that Tempus will
put on one line. If you specify zero, Tempus will put as many
references on a line as it can.

Digit Type

You have the option of Tempus displaying the references in digital
numerals or in normal (system font) numerals.

Return or Enter will start the cross-reference generation.

The Cross Reference

The first line of the generated cross-reference contains the search
string. The following lines contain the position information that the
search yielded. The information is displayed in the order line, column
and page number. This is dependent on which type of information
you asked to be generated.

The cross reference is generated in such a way, that you can use the
right mouse button to jump directly to the occurrence of the string
(see Chapter 6).
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AlLt-1 Append to file 1
AlLt-2 Append to file 2
AlLt=-3 Append to file 3
Alt-4 Append to file 4
ALt-Y Line
ALt-S Column
ALt-P Page
ALt-D Digital
ALt-N Normal
UAidle Cancel
Return start

Start
Enter

Sorting Lines

You can alphabetically sort all the lines in your text or those that are
in a block. The comparison for the sort begins in the leftmost
specified column and ends in the rightmost specified column.

Sort Lines (i_value = 16454)

- select Sort lines... in the Text menu
- use the keyboard shortcut Shift-Alt-S

The sort dialog box offers several options. You can specify whether
the entire text is to be sorted, or just the contents of the block
(provided it is defined). You can choose whether you would like an
ascending or descending sort and which columns of the lines are
affected by the sort. The last option is defined by entering the
number of the first and last column that will be considered relevant
by the sort. This is similar to the search option that specifies which
parts of a line will be searched.

Note: This command will not move either the block markers or any
bookmarks that you might have set.
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Shift-T Ascending
Shift-l Descending
ALt-G All lines
AlLt-B Block lines
AlLt-I min Col:
ALt—-X max Col:
tind Cancel
o

Sort
Return

Sort
Enter

Converting Characters

This command allows you to re-define the 256 ASCII characters. A
practical application of this command is conversion of upper to
lowercase letters and vice versa.

Convert Characters (_value = 16452)

- select Character conversion... in the Text menu
- use the keyboard shortcut Shiff-Alf-K

The following dialog box will appear when this command is invoked:
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In this dialog box you can specify the simple options of having upper
to lower case conversion and vice-versa, or you can edit the
conversion filter by hand on a letter-by-letter basis. Conversion
tables can be loaded and saved. Only half of one table is visible at a
time, i.e. only 128 characters are displayed at once. You can see the
other 128 characters in a table by clicking on the button in the
bottom right corner of the dialog box.

Each button represents one character. Each button can thus be
edited to specify which character a character should be replaced with.
The leftmost of the two characters (not counting the arrow) is the
‘search’ character, while the character on the right of the arrow is
the ‘replace’ character.

You can specify whether the entire text should be converted, or only
the currently-selected block.

Beware: the entire table is used during the conversion. If you want to
convert only one character, make very sure that the table reflects
this.

The Load and Save table commands enable you to load and save
entire conversion tables. Tempus contains the upper- to lower- and
lower- to upper-case conversions internally. Selecting the respective
buttons will cause pre-defined table to be put into place.

Double-clicking on the title of the dialog box, Character conversion,
causes the standard table to be used. The standard table is set so
that each character is replaced by itself. This make the construction
of a conversion table to change only one character much easier.

F1 lower — UPPER
F2 UPPER — lower
AlLt-L Load table
ALt-S Save table
ALt-G Whole text
AlLt-B Block area
Control-— Next page
Undo Cancel
Return g’frgr;r

Enter I
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Comparing Files

This command will compare the contents of all files that have open
windows. Tempus will then display the differences.

The comparison begins at the current cursor position and goes
toward the end of the text. If differences between any files are found
Tempus will stop and position the cursor at the beginning of the
differing area. If no differences were found, the cursors are
positioned at the end of the files.

Ends of lines are not used in the comparison, only the sequence of
characters matters.

Note: To continue comparing after a difference has already been
found, the cursors of the files must all be positioned after the
different area of text. This is not the same as in the search again
feature.

Compare Files (_value = 16456)

- select Compare files in the Text menu
- use the keyboard shortcut Shift-Alt-V

Removing Unnecessary Characters

This command removes certain irrelevant characters from the ends
of lines. The characters removed are:

-ASCII O

-ASCII 8

-CR (ASCII 13)
-Space (ASCII 32)

This command can be use to turn word-wrapped text into ‘source’

type text. All the characters that are needed in word wrap mode are
unnecessary in source mode.

Convert from Wrap d_value = 16460)

- select Convert from wrap in the Text menu
- use the keyboard shortcut Shift-Alt-E
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Converting Text to Wrap Mode

This command is useful if you would like to continue to edit text in
word wrap mode that, among other things, does not contain the

necessary paragraph information.
The following will be marked as ends of paragraphs:
- an empty line

- a line immediately preceding an empty line
- a line terminated by a period *.’

Since this command only provides general conversion, it is quite
possible that you might have to do some additional manual

conversion.

Convert to Wrap (_value = 16462)

- select Convert to wrap in the Text menu
- use the keyboard shortcut Shift-Alt-A

Note: This command can only be executed when in word wrap mode.

Reformatting Text Areas

Not all commands that can alter text in word wrap mode always
reformat it accordingly. The following commands address this

problem.

Reformat Text

This command reformats the whole of the text.

Reformat Text d_value = 16464)

- select Reformat text in the Text menu
- use the keyboard shortcut Shift-Alt-R

Note: This command is accessible only in word wrap mode.
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[Reformat Paragraph \

This command is identical to the previous one except that it
reformats only one paragraph. A paragraph is defined as the area of
text between the two CR characters containing the cursor. The
position of the cursor within this area is irrelevant.

Reformat Paragraph _value = 16466)

- select Reformat Paragraph in the Text menu
- use the keyboard shortcut Shiff-Alf-Return

Note: This command is accessible only in word wrap mode.

Clearing Text

This closes a file’s window and removes it from memory. You should
save the file before using this command.

Clear Text (_value = 16468)

- select Clear text in the Text menu
- use the keyboard shortcut Shiff-Alt-Delete
- drag the text’s icon into the Trash

If you have inadvertently deleted a file from memory, you can undo
the action by dragging the Trash icon back to the file’s icon or by
pressing the Undo key. This is only possible immediately after the
mistake has occurred.

It is wise to save your textfile before using Clear text since Tempus
will not warn you if you have made any changes to the text.

Undo

Some Tempus commands can be undone with the Undo key. This can
only happen immediately after the command in question has been
executed. The following are the commands which are undo-able.
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[Line Editing i

Tempus retains each line in a special buffer until you have started
editing another line. If you have edited a line and decide that you have
made a mistake, pressing Undo before going on to another line will
restore the contents of the line.

If the undo is successful, a dialog box will appear telling you which
line was restored. If you press Shift-Undo, the dialog box will not
appear. You can switch back and forth between the older and newer
versions of the line by pressing Undo (or Shiff-Undo) again.

[Deleting a Line

If you have deleted a line, e.g. with F8, you can undelete it with Undo.
Shift-Undo has the effect of not putting up a dialog box after the
undelete. You can switch back and forth between the deleted and
undeleted line by pressing Undo (or Shift-Undo) repeatedly.

[Deleting a Block |

A deleted block can be undeleted. A dialog box will not be displayed.

[Clearing Text \

If you have just cleared an entire file, dragging the Trash icon to a text
icon or pressing Undo will restore the text. A dialog box will not be
displayed, nor will a window automatically be opened for the restored
text.

Undo (_value = 16590)

- press the Undo key ‘

Undo without Dialog d_value = 16592)

- press Shift-Undo
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Structure Check

This command will perform a check throughout a file to see whether
there are any unbalanced open or close parentheses. You can also
choose to use a different string rather than parentheses. Pascal
programmers can check for balanced BEGIN and END statements, C
programmers can check for { and } etc.

The parameters for the structure test are entered in a form similar to
that used with the Search and Replace command.

Structure Check (i_value = 16476)

- select Structure Chk... in the Special menu
- use the keyboard shortcut Shift-Alt-H

The only difference between this dialog box and the Search and
Replace dialog box is that you enter the open and closing strings that
are to be checked for instead of the search and replace strings.

Note that you cannot use wildcards during a structure check.

The RPN Calculator

Tempus has a built-in RPN programmer’s calculator. RPN means
Reverse Polish Notation.

The calculator uses the concept of a stack to do its calculations. The
stack is four ‘registers’ in size; they are known as X, Y, Z and T. Each
register is 32 bits long.

Note: ENTER is used frequently in the following description. This
ENTER refers to the button in the calculator dialog box and not the key
on your ST's keyboard.

[What is RPN? ' ;

For those of you familiar with the way Hewlett-Packard calculators
function, the following description will contain nothing new.

You will notice that there is no = key on the calculator, nor are there
any parentheses keys. With an RPN calculator they are totally
unnecessary.
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The X register is the one that you see in the display field of the
calculator. When you enter a number, this number is put into the X
register. When you then click on ENTER, the contents of the four
registers are moved up one. The contents of X are copied to Y, the
contents of Y are moved to Z, and Z's contents are moved to T. The
previous contents of the T register are lost.

Example:

Entering the number 567:

X Y Z T
before 1 2 3 4
after 567 1 2 3
Click ENTER:
X Y Z T
before 567 1 2 3
after 567 567 1 2

Operations that have two operands are performed on the X and Y
registers. The final result will be in the X register, and the other
register’s values will be moved down one, i.e. in the opposite order
described above.

To execute an operation you first enter the operands and then the
operator.

Example:
567*3
X Y Z T
before 1 2 3 4
567 567 1 2 3
ENTER 567 567 1 2
3 3 567 1 2
5 1701 1 2 2
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IThe Keys on the Calculator

DEC
HEX

BIN
@ECT
=> Text

AND
OR

XOR
NOT
NEG

CLX
ENTER

display numbers using the decimal base

display numbers in hex (base 16)

display numbers in binary (base 2)

display numbers in octal (base 8)

copy the currently displayed value to the current cursor
position

logical AND, performed on X and Y

logical OR, performed on X and Y

logical XOR (exclusive OR), performed on X and Y

produce the 1s complement of X

negate the contents of X, i.e. produce the 2s complement
add Xand Y

subtract X from Y

multiply X and Y

divide Y by X

return Y MOD X. e.g. if Y is 14 and X is 3, the result will be

2. 14 divided by three is 4 with 2 left over. The remainder
is the result of the modulus operation.

clear the contents of the X register

move the values of the registers up to the next register,
ie. XtoY, YtoZ ZtoT. The valuein T is lost.

RPN Calculator ¢ _value = 16542)

- select RPN Calculator in the Special menu
- use the keyboard shortcut Shift-Help

The Calculator is brought to the front, regardless of whether it was
already open or not.

Quit RPN Calculator _value = 16716)

- Click in the Calculator’s close box
- use the keyboard shortcut Control-Help
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gorQ DEC
worW HEX

r or R BIN

oor 0 (@1
torT => Text

& AND

| OR

A XOR

& NOT L}
! NEG

+ +

* *

/ /

% %

ESC CLX
Return ENTER
Enter ENTER
0::29 digits

A ForAv.. B hex digits

If an error occurs during a calculation, Tempus will give a warning
beep. An example of an error is division by zero.

Tab Character

After loading text that contains the tab character (ASCII 9), Tempus
will not automatically convert the tab to spaces. Certain commands
allow control over tab characters.

[Expand Text |

With this command, Tempus will replace any tab characters within
the file with the number of space characters equivalent to the current
tab length (see Chapter 9 for details on how to set the tab length).
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Expand Text d_value = 16478)

- select Expand fext in the Special menu
- use the keyboard shortcut Confrol- (Control and the minus
key)

|Compress Text B

This is the complement of the previous command. Tempus will
replace every sequence of spaces of the current tab size with tab
characters.

Beware: Do not use this command on text that already contains tab
characters. Tempus cannot tell tab characters from spaces; it is
highly probable that your text would end up looking quite different
from what you expected.

Compress Text d_value = 16480)

- select Compress text from the Special menu
- use the keyboard shortcut Alf-- (Alf and the minus key).

Character Size

If Tempus is running in monochrome mode you can select the size of
the characters that it uses to display text. The settings for each of
the four loaded files are independent of one another.

Tempus can display characters in either the 8x8 or 8x16 system
fonts. In medium resolution, Tempus can display text only in the 8x8
font.

8x8 Text Display (_vaiue = 16530)

- select 8x8 in the Special menu
- use the keyboard shortcut Control-8

8x16 Text Display _value = 16532)

- select 8x16 in the Special menu
- use the keyboard shortcut Control-0 (the digit 0)
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Fonts

Tempus normally uses the fonts provided by the system to display
text. You can also load previously defined fonts from disk to be used
to display text. The character set must be in DEGAS format i.e. the
first data byte is the bitmap of the uppermost line of the first
character; the first character is 0 not 1. The second byte represents
the second line of